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License Agreement  
Software License Agreement  

Breaking the seal on this envelope indicates your agreement to be bound by the terms of this 
agreement. If you do not agree with the terms of this agreement, DO NOT break the seal, but 

promptly return unopened this disk envelope and the other items (written materials, binders, and 
containers) to Order-Matic Corporation for a full refund.  

IMPORTANT  

Thank you for purchasing this Order-Matic Corporation software product.  

It is important that you carefully read the following agreement prior to opening this disk envelope.  

License Grant  

This is a license, not a sales agreement, between you, the end user, and Order-Matic Corporation. 
Order-Matic grants you a non-exclusive, non-transferable (except as provided below) license to use the 
copy of the software enclosed in this envelope and the accompanying documentation in accord with the 

terms set forth in this License Agreement. You May:  

�.a. Install the software on only one (1) computer.  
�.b. Make one (1) copy of the software in machine-readable form for backup purposes; provided that you 
reproduce all proprietary notices on the copy.  
�.c. Physically transfer the software from one (1) computer to another provided that the software is used on 
only one computer at a time.  
�.d. Transfer (not rent or lease) the software on a permanent basis if the person receiving it agrees to the terms 
of this Agreement.  
 

You May Not:  

�.a. Use the software on more than one (1) computer, workstation, or file server at a time in a network or a 
multi-user system.  
�.b. Modify, translate, reverse engineer, decompile, disassemble, create derivative works based on, or copy 
(except for the backup copy) the software or the accompanying documentation.  
�.c. Rent or lease any rights in the software or accompanying documentation in any form to any person without 
prior written consent of Order-Matic Corporation which, if given, is subject to the transferee’s consent to the 
terms and conditions of this license.  
�.d. Remove any proprietary notices, labels, or marks on the software, documentation, and containers.  
 

All rights, title, interest, and all copyrights to the software, documentation, and any copy made by you 
remain with Order-Matic Corporation. Unauthorized copying of the software or the documentation, 

or failure to comply with the above restrictions, will result in automatic termination of this license and 
will make available to Order-Matic Corporation other legal remedies.  

LIMITATIONS OF REMEDIES  

Your sole remedy under this License Agreement shall be repair or replacement as provided in the 
warranty. Order-Matic Corporation sole and exclusive maximum liability for any claim by you or 

anyone claiming through or on the behalf of you arising out of your order or the warranty shall not 
in any event exceed the actual amount paid by you to Order-Matic Corporation for the product. IN 

NO EVENT SHALL ORDER-MATIC CORPORATION BE LIABLE FOR ANY INDIRECT, 
INCIDENTAL, COLLATERAL, EXEMPLARY, CONSEQUENTIAL OR SPECIAL DAMAGES 
OR LOSSES ARISING OUT OF YOUR ORDER OR DISKS DELIVERED UNDER IT OR OUT 

OF THE WARRANTY, INCLUDING WITHOUT LIMITATION LOSS OF USE, PROFITS, 
GOODWILL OR SAVINGS, OR LOSS OF DATA FILES, OR PROGRAMS THAT MAY HAVE 

BEEN STORED BY THE USER. SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 

LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.  

LIMITED WARRANTY  
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THE SOFTWARE AND DOCUMENTATION IS PROVIDED “AS IS WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU, AND YOU 

ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.  

SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, 
SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC 
LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.  

Order-Matic Corporation does NOT warrant that the function contained in the software will meet your 
requirements or that the operation of the software will be uninterrupted or error free. However, Order-Matic 

Corporation warrants the media disk on which the software is furnished to be free from defects in material and 
workmanship for a period of one (1) year from the date of shipment by Order-Matic Corporation to you. Order-

Matic Corporation shall, at its option and cost, either repair or replace the media disk with a new or 
reconditioned disk provided the disk is returned by you to Order-Matic Corporation along with the dated and 

serialized proof of purchase, transportation and insurance prepaid, within the above warranty period, and 
provided the disk is found by Order-Matic Corporation to be defective within the terms of this warranty. Disks 

repaired or replaced shall be returned by Order-Matic Corporation to you, transportation and insurance 
prepaid. Returned defective disk shall become the property of Order-Matic Corporation. If any disk returned 
by you to Order-Matic Corporation for repair or replacement is found by Order-Matic, after examination and 
testing, not to be defective, Order-Matic Corporation shall so advise you and shall dispose of any such disk in 

accordance with your instructions and at your cost, and you shall reimburse Order-Matic Corporation for 
examination and testing expenses incurred at Order-Matic Corporation’s then current rates.  

CONTINUED USE OR POSSESSION OF THE DISKS AFTER EXPIRATION OF THE ABOVE ONE (1) 
YEAR WARRANTY PERIOD SHALL BE CONCLUSIVE EVIDENCE THAT THE WARRANTY IS 

FULFILLED TO THE FULL SATISFACTION OF PURCHASER.  

The warranty set forth above shall not apply to any failure or deficiency which has been caused by misuse, 
neglect, alteration, improper installation, unauthorized repair or modification, improper testing, accident or 
causes external to the disk, such as, but not limited to, excessive heat or humidity, power failure, or improper 

installation. Order-Matic Corporation’s warranty as set forth above shall not be enlarged, diminished or 
affected by, and no liability shall arise out of, Order-Matic Corporation rendering of technical advice or service 

in connection with your order. The warranty set forth above is not assignable by you.  

GENERAL  

You may terminate this license at any time by destroying all copies of the software or by returning them to 
Order-Matic Corporation. Order-Matic Corporation may terminate this license if you fail to comply with the 

terms and conditions of this License Agreement. Upon such termination, you agree to destroy or return all your 
copies of the software. You agree to be responsible for the payment of any taxes resulting from this Agreement. 
Any unauthorized rental, lease, assignment or (except as provided above) transfer of any copy of the software 

shall be void. If any provisions of this Agreement are held invalid, the remainder shall continue in full force and 
effect. This License Agreement shall be governed by the laws of the State of Oklahoma 
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Store2Office First Time Setup 
 

Running Store2Office for the First Time:  
 
You must configure all Options in the Store2Office Communicator before Store2Office 
Functionality can be achieved. 
 

Adding Stores to Store2Office Communicator 
 

Open the Store2Office Communicator by clicking the  
 
The Communicator Opens: 
 

1. Double-Click on the 
first line under the 
ID# field and enter 
the 4-Digit Store 
Code for the Store. 

2. Double-Click on the 
first line under the 
Store Name field and 
enter a name for the 
location (Address, 
City, Market Area, 
etc) 

3. Double-Click on the 
first line under the 
Store Number field 
and enter the store’s 
phone # with area 
code (Note: If using Modem to Communicate with the store, this must be the 
phone # for the modem at the store).  

4. The Notes field is left blank. This will populate once the Office begins receiving 
files from the Store. 

5. POS Version will populate from the Store, alerting you to the POS Version the 
Store is using. 

6. E2 Version will populate from the Store, alerting you to the POS Version the 
Store is using. 

7. Office DB Start/End Dates will populate as the Store begins sending data. Begin 
is the first date of information sent from the store; end is the last date of 
information sent from the Store. 

 
Repeat Steps 1-3 on the following lines for each Store. 
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Configuring Store2Office Communicator Settings 
 
Open the Store2Office Communicator and Click the [Options] Button: 
 
General: 

1. Enter a Group Name, User 
Name and Email Address in 
the appropriate Fields.  

2. Select a connection type for 
Store Communication 
I use a Modem to access store 
information is used to get 
store data via Modem and 
telephone line. Select this 
option if this is how you wish 
to access your store’s data. 
I use a FTP to retrieve store 
information is used to get 
store data via FTP Site. Select 
this option if this is how you wish to access your store’s data and you have an 
FTP Site configured (Contact OMC’s Support Center for more information). 

3. Select Office Machine Type: 
Main Office Server: is used for the Main Office. Only one Main Office per 
group may be selected. This configuration should be responsible for Supervisor 
Setup and is capable of editing Menu Profiles, Chart of Accounts, and 
Exception Parameters. The Main office may share its data via network with 
other Store2Office Clients. 
Client @ Main Office: is used for a Client PC on the same network as the 
Main Office Server. The Client views it’s data from the Main Office Server 
should not be responsible for Remote Menu Maintenance. This setting is 
designed for viewing data only. 
Supervisor (Remote Machine): is used for secondary Store2Office users to 
access some of the same data as the Main Office Server. A Supervisor Machine 
can be assigned stores to view by the Main Office. This profile has the 
capability of Remote Menu Maintenance, but it is recommended to maintain 
Menu Profiles from the Main Office Server. The Main Office Server designates 
Supervisor Numbers that associate certain stores with a certain Supervisor(s).  
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Modem Setup: If using 
Modem for data, configure 
the Modem Setup option. 
This is basic information 
about your modem. 
 

 
 
 
 
 
 
 
 
 
 
Database Profile:  Use this 
Tab to specify where the 
Databases for Store2Office are 
located, if not in the same 
directory as Store2Office (used 
primarily on networks or for 
Client Machines at the Main 
Office. 
 
 

 
Labor Information: This 
information is used by the S2O 
to sort Payroll received from 
store locations. This will not 
affect the stores, only the 
viewing options in S2O. 
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FTP Setting: 
Connection Info:  
This option is used only if the 
Store2Office will use Modem 
to communicate with the 
Stores. The Dial-Up 
Information can be entered 
here and will allow the 
Store2Office to connect to the 
ISP before downloading Store 
Information.  

**Make sure Use Dial Up is checked ONLY if you are using Modem…for FTP, 
this option must be unchecked** 

 
FTP Transfer Profile: 
These settings are entered 
if the Store2Office will 
use FTP to download the 
Store’s Data. These 
settings must be 
configured with the help 
of Order-Matic, as they 
apply to Group-Specific 
login information. These 
settings must be entered 
before Store2Office will 
receive any Store Data.  

 
 

 
 
 

 
Supervisor Setup:  

This option is used only at the 
Main Office Server to designate 
Supervisors to receive FTP Files. 
Each Supervisor is assigned a 
number and which stores he/she 
will receive data from. Once all 
FTP Settings are entered, new 
Supervisors can be created. 
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How to Setup a New Supervisor 
 

1. Open S2O Communicator 
2. Click [Options] 
3. Select [Supervisor Setup] from the Tree 
4. The following box will open: 
5. Right Click [Alternate FTP 
Transfer] and select [Add 
Supervisor] 
6. Click [Yes] 
7. Enter the Supervisor’s Name. 
Make this name distinctive for 
identification 
8. This will create the 
Supervisor. Left Click the Name 
to see the 

 information. The Supervisor ID will be used to configure 
Supervisor S2O Machines. 
9. Right Click the newly created Supervisor’s Name and select [Assign Stores]. A 
list of stores in the S2O will appear on the far right 
10. Left Click all stores that this Supervisor will receive files for. This will move the 
selected stores to the  field. 

11. Click  to save the Supervisor Settings. 
12. Repeat Steps 5-11 for additional Supervisors. 
13. Click [Apply] and [Ok] to close the Options window 
 

 

How to Edit Existing Supervisors 
 

1. Open S2O Communicator 
2. Click [Options] 
3. Select [Supervisor Setup] from 

the Tree 
4. The following box will open: 
5. Right click the existing 

Supervisor’s Name and select 
[Assign Stores] 

6. Left Click all stores that this 
Supervisor will receive files 
for. This will move the 
selected stores to the 
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 field. 

7. Click  to save the Supervisor Settings. 
8. Repeat Steps 5-8 for additional Supervisors. 
9. Click [Apply] and [Ok] to close the Options window 

 

How to Delete a Supervisor 
 

1. Open S2O Communicator 
2. Click [Options] 
3. Select [Supervisor Setup] from 

the Tree 
4. The following box will open: 
5. Right click the existing 

Supervisor’s Name and select 
[Delete] 

6. Click [Yes] to confirm the 
Delete. 

7. Repeat steps 5-6 to delete 
additional Supervisors 

8. Click [Apply] and [Ok] to 
close the Options Window 

 
 

Store Profiles:  
This option lists all stores 
that the Office will receive 
data from, along with their 
individual information 
(Phone #, Manager, 
Payroll/OT settings). These 
settings must match those 
at each corresponding Store. Fill out all information for each store listed in the Profile. 

 
Once all Store2Office Communicator Setup is complete, each store must be setup 
with complimentary settings to allow data transfer. Order-Matic can assist with this 
process.  
 
Each Store and the Office must have access to either the Internet (for FTP Transfer) 
or have a modem with a dedicated phone line (for Modem Communication). 
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To Download Files Using FTP 
1. Open Store2Office Communicator and click the [FTP Transfer] button. This will 

initialize the FTP Transfer Script, connect to the FTP, and download all FTP files 
from the appropriate folder on the FTP Site (depending if it is a Main Office 
Server or a Supervisor Machine). 

*Internet Connection must be active for FTP Transfer to be successful* 
2. Once all FTP files are 

downloaded, they will 
process automatically. 
If they do not, click 
the [Process Files] 
button and the Import 
screen will open. 

3. Close Store2Office 
Communicator or 
press the [View 
Reports] button to 
open the Store2Office 
Reporter. 

 
 

Viewing Files from a 
Store 

 
Once data is downloaded and processed, you can now view it in the 
Store2Office Reporter. To view data from a Store: 

1. Open Store2Office Reporter using the  Icon. 
2. Select the appropriate Store from the 

 drop-down. You may also 
use the Left/Right Arrows to scroll between Stores. The name 
listed will correspond with the name you entered in the Store 
Name field in Store2Office Communicator. 

3. Select the appropriate report in the S2O Reporter List Bar (as seen 
on right): 
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Printing Reports in Store2Office Reporter 
 

**Note: In order to print reports from the Store2Office Reporter, you must have a printer 
installed and working properly** 

1. Select the Report you wish to print from the List Bar: 

2. Click the  or Navigate [File] > [Print] 
3. The selected report will print 

 

Using the Calendar Wizard 
 

The Calendar Wizard allows you to 
sort reports in Store2Office in various 
ways, depending on the report 
selected.  

1. Select the Report you wish to 
view from the List Bar 

2.  Click the  
button 

3. Select the Reporting 
options/Date Range you wish 
to view 

4. Click [Done]. The report will 
display as selected. 

**Note: Any option that is grayed out 
is not available for the Currently 
Selected Report** 
 
 

Edit Options 
 

Store2Office’s application settings are under the Edit Menu. These settings allow the user 
to configure Store2Office Reporter’s Viewing Options. 
 

Application Settings… 
 
 General Tab: The User Name, Group Name and Email Address are pulled from 
the Store2Office Communicator, though they can be changed here as well. The 
communication method is also listed from the Communicator (FTP or Modem). 
 
 Labor Information Tab: This information comes from the Store2Office 
Communicator and lists the viewing options for the downloaded store information. 
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 Database Profile: This tab lists the location of Store2Office’s databases. This is 
typically standard, but in the event of a network or Main Office/Client setup, the database 
location may differ. 
 
 Report Settings:  
This tab allows the S2O user to 
customize Product Categories, 
Rankings Reports and Payroll 
Viewing Options.  

Product Categories:  
This field is used in the Menu 
Item Settings and Product Mix 
reports as sorting options. 
Click [Add] to add a new 
Category, Click [Remove] to 
delete a selected Category. 

Ranking Settings: 
These settings are used to give 
a weighted score to each store 
in the S2O. The user can assign 
point-values to each of the 
categories listed, and the Rankings report in S2O Reporter will sort the stores based on 
their points scored.  

Expand/Collapse Buttons:  
This option is used to default the viewing options for the Payroll Summary and 
Transaction Summary Reports. 
 

Tools Options 
 

Tools will include most of the Import/Export features of 
S2O, along with Remote Menu Maintenance and Menu 
Indexing features.  
Go To Previous/Next Date Interval:  
Serves the same function as the Arrow Buttons on the 
Calendar wizard does. It uses the current reporting option 
in Calendar Wizard (Weekly, Monthly, etc) and moves 
the interval forward or back. 
Calendar Wizard:  
Opens the Calendar Wizard for the Currently Selected 
Report. 
Export to HTML: 
Exports the Currently Selected Report to HTML format, 
viewable by Internet Explorer 
Export to Excel:  
Exports the Currently Selected Report to Excel format, viewable by Microsoft Excel. 
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Master List Import:  
Allows the user to import a Standard Menu File for the purposes of Menu Indexing 
(Sonic-Specific configuration).  
Menu Assignment:  
Opens the Menu Indexing Utility, allowing the User to index a store’s menu items with 
the Master Reference List (Master List Import).  
Remote Menu Maintenance: 
Opens the Remote Menu Maintenance Utility. This utility allows the user to send Menu 
Profiles to the stores via FTP site.  
 

How To Import a Master List for Menu Indexing 
 

1. Download the Master List. 
This option is currently a 
Sonic-Specific option, so 
the Master List is available 
on the Partnernet Website 
for download. 

2. Navigate [Tools] > [Master 
List Import] 

3. Select the location of the 
downloaded Menu Import 
File by clicking the […] 

4. Once the list is imported, 
click exit to close the 
utility. 

 

How to Use the Menu Indexing Utility 
 

The Menu Indexing Utility allows the User to Index the Store’s Menu Items with a 
Master Reference List using a PLUID number. This allows an office location to track 
Product Mix reports and Ideal/Actual Inventory numbers while maintaining product data 
integrity.  
 

1. Select the Store you wish to Index using the Store List drop-down 
2. Navigate [Composer] > [Menu Item Settings] 
3. Navigate [Tools] > [Menu Assignment]. This will bring up the Menu Indexing 

Utility.  
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4. Select an Un-Indexed 
Item from the Store 
Menu Item List. 
**Note: All Un-
Indexed items have a 
0 PLU ID** 

5. Locate the 
appropriate item from 
the Sonic Indexing 
List. **Note: Click 
Details and use key 
words to search for 
the appropriate 
item** 

6. Click the box beside 
the index item. The 
“Click here to 
Update” button 
should appear at the top of the utility. **Note: To Index more than one item to the 
same Sonic Indexing List item, index the first item, then click the Multiple 
Assignment Button to assign the other items** 

7. Once all items are indexed, click [Click here to Update] and [Exit] to close the 
Utility. 

8. The [Save Changes] button pops up in the Menu Item Settings. Click it and the 
Menu Profile Options will open (See How to Create a Menu Profile) 

**Note: Anytime a menu item is changed at the store, the new item will have to be 
indexed** 

 

How to Create a Menu Profile 
 

Creating a Menu Profile allows the S2O to not only send Menu Indexed PLU ID #’s 
to a Store, but also to edit the menu itself, if necessary.  
**This utility will open automatically if the Menu has just been indexed. 
 
1. Select the appropriate store from the Store List drop-down 
2. Navigate [Composer] > [Menu Item Settings] 
3. Make all necessary changes to the selected menu (or index the Menu if needed). 

These changes can include Menu Indexing, menu names, pricing, etc. 
4. Click [Save Changes] 
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5. The Profiles Interface will open: 
6. Select which profile slot to 

save this Menu Profile to. 
**Note: There are 9 
Available Profiles in which 
to save a Menu** 

7. Enter a Profile Description. 
Make sure that the 
description is easy to 
understand and clarifies 
which store the profile 
belongs to. 

8. Enter Edited by information 
9. Click [Next] 
10. This will save the Profile to 

the default directory 
(typically c:\program 
files\store2office) 

 

How to use Remote Menu Maintenance 
 
Remote Menu Maintenance is used to send a previously created Menu Profile (see How 
to Create a Menu Profile) to a Store. 
 

1. Click [Tools]  
2. Click [Remote Menu Maintenance]. The following interface will open: 
3. Step 1: Select the 

store(s) that will receive 
this profile (click the 
box beside each). 
**Note: the selected 
store’s menu type is 
listed beside the Store 
Name (XDQ or ADQ). 
Take care not to send 
an ADQ profile to an 
XDQ store, or vise 
versa** 

4. Step 2: Select the date 
for this profile to take 
affect. Make sure to 
allow at least 3 days in 
advance for the profile 
to take affect…this will 
allow the store to download it in plenty of time to make the Effective Date. 
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5. Step 3: Select which Profile to send. This drop-down will list all profiles that 
have been created. Select the profile will be sent to this store (naming the profile 
properly is key to ensuring this).  **Click [View Profile] to verify the profile is 
the correct one. 

6. Click [Build Files]. This will create the file and pop up the following message: 
7. Click [Ok] and [Exit] to close the interface. 
8. Repeat for all stores to which you wish to send a 

profile. 
9. Close S2O Reporter 
10. Open S2O Communicator 

11. Click the  button to connect to the 
FTP Site and send the menu profile. The profile will be downloaded to the 
appropriate store the next time the store sends an FTP file (it’s part of the FTP 
Transfer process).  

**Once the file is downloaded at the store, it will take effect after the End of Day Sync 
the night before you set it to go into effect (example: if you set it to take effect on Feb 15, 
2006, it will program the new menu on Feb 14, 2006 after the EoD). This will allow the 
store’s menu to be up-to-date on time!  
 

Importing a Backup Profile 
 
If the profile creation process was interrupted by an invalid item, etc, S2O offers the 
capability of importing a backed up profile in version 2.1.0.203 and higher.  
 

1. Close S2O Reporter and Communicator 
2. Right Click the S2O Reporter Icon and select [Properties] 
3. Click [Find Target]. This will open the S2O Directory 
4. Double Click the [MenuFiles] Folder 
5. Click [View] > [Details]. This will allow the Last Modified Date to show on all 

files in the Folder 
6. Rename the keymap.ss3 file to “oldkeymap.ss3” 
7. Based on the Last Modified Date, select the menu profile you wish to import. The 

menu profiles have the following naming convention:  
8. Rename this file to “keymap.ss3” 
9. Open S2O Reporter 
10. Navigate to [Composer] > [Menu Item Settings] and 

select a store with the same style keyboard as the profile you selected 
(ADQ/XDQ) from the Store drop-down. 

11. Click [Tools] and select . The following message will appear: 
12. Click [Yes] 
13. The Browse Interface will open; navigate to 

the MenuFiles Folder (default path is usually 
c:\program files\Store2Office\MenuFiles). 

14. Select the MenuFiles folder and click [Ok] 
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15. The following Interface will open: 
16. Click [Preview…] to view the 

Menu Profile you renamed. 
Verify this is the correct menu. If 
not, repeat steps 1-14, selecting a 
different Menu Profile to 
rename. 

17. Click [Continue >>] to import 
the selected menu profile. 

18. The [Save Changes] button appears on the Menu Item Settings, and all changed 
items are highlighted in yellow boxes. Preview these changes again to ensure 
accuracy 

19. Make any changes necessary to complete the menu profile (these changes may 
include Menu Indexing, naming, pricing, etc) 

20. Click [Save Changes] 
21. The Menu Profile Interface will open (see How to Create a Menu Profile) 

 

Exporting a Menu File 
 
The Menu File Export Options allow the user to export the currently viewed menu file to 
a keymap.ss3 file, which can then be used for backup (see Importing a Backup Profile) 
or to manually import a menu at a store location. 
 

1. Navigate [Composer] > [Menu Item Settings] and select the appropriate store 
from the Store Name drop-down. This will be the menu file you wish to export, so 
be aware of menu type (ADQ/XDQ).  

2. Click [Tools]  
3. Select [Export Menu] and the following appears:  
4. Click [Yes] 
5. Select the directory where you 

wish the keymap.ss3 stored. 
**Note: If you select the 
MenuFiles folder, make sure to 
rename any existing keymap.ss3 
files in advance, or it will 
overwrite them**  

6. The following 
appears:  

7. Click [Ok]. This 
will save the new 
keymap.ss3 to the 
path you selected. 
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Checking Version/Build of the Store2Office 
 
It will be necessary to update your S2O when new updates become available. These 
updates may include new features, program corrections or cosmetic improvements, and 
will be invaluable to your use of the S2O program. In order to determine if an update is 
needed, you will need to check the version/build of the software before contacting the 
Support Center.  
 

1. Click [Help] 
2. Click [About Store2Office]. 

The About Box will appear: 
3.   The Version and Build will 

be in blue, as seen here: 
. The 

Support Center technicians 
will be able to identify if 
there is a newer version of 
the software available. 
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S2O Composer 
 
S2O Composer is similar to the Composer module in the E2 Management Suite. It lists 
all Equipment Settings, Menu Settings and store configuration. It differs from the E2 
Management Suite in that the settings listed in S2O Composer, save those in Menu Item 
Settings, cannot be changed and sent to the Store… they can only be viewed. 
 

Store Information 
 
The Store Information 
option lists all Ticket 
Information, Tax 
Rate, Monitor 
Sections, No Tax 
Sections, and Security 
Codes for the 824 
POS.  
 
 
 
 
 
 
 
 
 
 

Equipment Settings 
 
Equipment Settings lists all store-specific equipment configurations.  All Printer, 
Monitor, Av-Time and Keyboard Settings are listed here.  
 
 
Printer Settings: 
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Monitor Settings:  
 
 
 
 
 
 
 
 
 
 
 
 
Av-Time Settings: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Keyboard Settings: 
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Time Functions 
 
Time Functions lists all store-specific Time-Based Settings from the 824 POS. Shift 
Times, Late Times, and Keyboard Recall Functions are all listed here. 
 
 
 
Shift Times: 
 
 
 
 
 
 
 
 
Late/Happy Hour Times: 
 
 
 
 
 
 
 
 
Keyboard Recall Functions: 
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Keyboard Settings 
 
Keyboard Settings lists store-specific Green Condiment Keys (designation and position) 
and Discount % Keys  
 
Green Condiment Keys: 
 
 
Discount % Keys: 

 
 

Menu Items Settings 
 
Menu Items Settings lists all store-specific menu information. This includes Menu 
Names, Pricing, Key Status, PLU ID, Category, and Long Description (if Menu Indexed). 
From this module, you can also view the keyboard in Overlay format, view Historical 
Key Settings, and View/Edit Menu Profiles (see How to Create a Menu Profile). 
 
Menu Item Settings: 

 
 
Keyboard Overlay: 
Shows the current Menu Item Settings in an Overlay format 

 
 
Historical Settings: 
Shows the currently programmed Menu Item, along with past Settings for that key 

 
 
View/Edit Menu Profiles: 
Allows you to view previously created profiles using the drop down, or create a new 
profile (see How to Create a Menu Profile) 
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Production Line Settings 
 
Production Line Settings lists the store-specific Recipe and Production Line Settings. 
 
Recipe Settings:  
Shows the currently set Recipe 
Settings for the current store’s 
Menu Items. This describes how 
many of each Raw Good is 
needed for production of the item. 
 
Production Line 
Items: 
Shows the currently 
programmed 
Production Line, 
including Raw Goods 
and Monitor 
placement of each. 
 
 
 
 
 
 
 

824 Employee Settings 
 
824 Employee Settings lists the store-
specific employees programmed into 
the 824 POS. This includes clock 
code, Employee Name, SSN, and Pay 
Rate.  
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Ticket Trailer 
 
Ticket Trailer lists the store-specific Ticket 
Trailer information. Includes the Trailer 
Message, Printing Options and Interval. 
 
 
 
 
 
 
 
 
 

EPS Settings 
EPS Settings lists all store-specific EPS or PAYS information. This information includes: 
Store Name, Store ID, POS Version, Keyboard Type, Status of EPS/Gift Card 
(enable/disable), GC Activate and Reload Keys and Sections, and all EPS Account 
Numbers. 
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S2O Reporter 
 
S2O Reporter is similar to the Reporter function in the E2 Management Suite, allowing 
the user to view Daily Summary, Shift, Exception, Hourly/Qtr Hourly, Blue Book, Status, 
Detailed Tickets, and Product Mix reports. S2O Reporter also allows the user to view a 
Rankings Report, which settings can be configured in [Edit] > [Application Settings] > 
[Report Settings].  

Daily Summary 
Lists all store-specific Transactions, Deposits, and Ticket 
Information in a Daily format. This report also includes all 
EFT Deposits (if stores utilize the EPS or PAYS). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Shift Info 
Lists all store-
specific Daily 
Information, broken 
down by Shift Time 
(programmed in the 
824 POS).  
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Exception Report 
Lists the Exception Parameters programmed 
from the Account Maintenance Section in 
the Cash Controller Module in S2O.  

 

 

 

 

 

 

Hourly/QTR Hourly Report 
Lists all store-
specific 
Hourly/QTR 
Hourly 
Information. 
 

Blue Book 
Lists all store-specific Sales Information broken down by Day, but including some shift 
information. Can be viewed by: Dates, Running Sum, Week, Month, or Multi-Store. 

 
 

Status Report  
Lists all store-specific information in a weekly format, broken down by shift. Also 
includes Product Mix information.  
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Detailed Ticket 
Lists all store-specific detailed ticket information. 
This information includes Recalled Tickets, 
Canceled Tickets, Late Tickets, and Unclaimed 
Call-Ins.  

Product Mix Info  
Lists all store-specific Product Mix information.  

 
 

Rankings 
Generates a Rank report based on settings configured in the Application Settings of the 
S2O ([Edit] > [Application Settings] > [Report Settings]). This report gives weighted 
values to each store in the database based on the score for each category. The report also 
ranks the stores based on their total score. 

 
 

Labor Information 
 
Labor Information lists all store-specific Timesheet, Payroll, and Tip Information. All of 
this information is generated at the store and cannot be edited in the S2O. 
 

Employee Profile 
Lists store-specific 
Employee information. 
This information is 
similar to the Employee 
Settings in S2O 
Composer, but also 
includes all Date of Birth, Contact, and Personal Information needed for Payroll.  
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Timesheet 
Lists all store-specific Timesheet information. This includes Clock In/Out Times and 
Dates, as well as Pay Rate and Tip Information. All edits to the Timesheets also display 
in the Audit Trail. 

 

Payroll Summary 
Lists all store-specific Payroll information including: Employee Information, Clock 
In/Out Times/Dates, Total Day/Week Regular and OT Hours, Tips, Charges, 
Adjustments and Net Wages. 

 
 

Condensed Payroll Report 
Lists all store-specific Payroll information in condensed format. This information is 
based on and populated from the Payroll Summary Report and reports the entire Pay 
Period. 

 
 

Monthly Tips Sheet 
Lists all store-specific Tip information entered in the Cash Drop. This information is 
optional. 

 
 
 

Cash Controller 
 
Cash Controller lists all store-specific Cash Drop information, as well as the Vendor, 
Chart of Account, and Transaction Journal Entries from each location. From this Module, 
the users can Edit Chart of Accounts, Vendors, and Exception Parameters information. 
This information can then be sent to a store via FTP Transfer, similar to the Remote 
Menu Maintenance. 
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Account Maintenance 
Opens an interface 
that allows the 
creation of Chart of 
Accounts, Vendor, 
and Exception 
Parameter files.  

 

 
 
 
 
 

How to Create a Chart of Accounts and Send it to the Stores 
 
**Note: When sending a Chart of Accounts, the file will be sent to all stores in the S2O 
Communicator. Therefore, ensure that this Chart is suitable for all E2 recipients. If not, 
individual changes must be made in the E2 Management Suite** 
  
 Editing Existing Accounts 
 

1. Click [Account Maintenance] 
2. Highlight the Account you wish to Edit 

3. Click  
4. Make necessary changes by using the field listed below: 

 
 

5. Click  
6. The Edit Mode box appears, click [Yes] 
7. Repeat steps 2-6 for all Accounts that are 

being edited 
8. If any Vendor or Exception Parameter 

changes need to be made, make these changes 
now (see How to Create Vendor List and 
Send it to the Stores and How to Create Exception Parameters List and Send 
it to the Stores) 
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9. Once all needed changes are made to all 3 reports, click  
10. Select which reports you wish to send to the stores: 

 
**Note: If you edit a report, and decide to edit a different one later on (Chart of Accounts 
now, Vendor List later on), it will add to the existing O-File whatever additional changes 
you have made** 

11. Click  
12. Click [Ok] 

13. Click . The file has been created and is ready to FTP Transfer to the 
stores. 

**Note: When Chart of Accounts, Vendor, or Exception Parameter files are created, it 
creates an OXXXX.zip file (where XXXX is the Store Code) and places it in the S2O 
Directory’s FTP Out Folder. This folder sends all Menu Profiles and O-Files to the stores 
when the S2O Communicator performs an FTP Transfer. 
 
 Creating New Accounts 
 

1. Click [Account Maintenance] 

2. Click  
3. Enter new account information in the following field 

 
 

4. Click  
5. Repeat steps 2-4 until all new accounts are created 

6. Click  
7. Select which reports you wish to send to the stores: 

8.  
**Note: If you edit a report, and decide to edit a different one later on (Vendor List now, 
Chart of Accounts later on), it will add to the existing O-File whatever additional changes 
you have made** 

9. Click  
10. Click [Ok] 
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11. Click . The file has been created and is ready to FTP Transfer to the 
stores. 

 
 Deleting an Existing Account 
 

1. Click [Account Maintenance] 
2. Select the Account you wish to delete 

3. Click  
4. The Delete Account box appears: 

 
 

5. Click [Yes] 
6. Repeat steps 2-5 until all unwanted accounts are gone. 

7. Click  
8. Select which reports you wish to send to the stores: 

 
**Note: If you edit a report, and decide to edit a different one later on (Vendor List now, 
Chart of Accounts later on), it will add to the existing O-File whatever additional changes 
you have made** 

9. Click  
10. Click [Ok] 

11. Click . The file has been created and is ready to FTP Transfer to the 
stores. 

How to Create Vendor List and Send it to the Stores 
 
**Note: When sending a Vendor List, the file will be sent to all stores in the S2O 
Communicator. Therefore, ensure that this List is suitable for all E2 recipients. If not, 
individual changes must be made in the E2 Management Suite** 
 

1. Click [Account Maintenance] 
2. Click the Vendors Tab 
3. Highlight the Account you wish to Edit 
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4. Click  
5. Make ALL necessary changes to the account in the following field: 

 
 

6. Click  
7. The Save? Box appears: 

 
 

8. Click [Yes] 

9. Click  
10. Select which reports you wish to send to the stores: 

 
**Note: If you edit a report, and decide to edit a different one later on (Vendor List now, 
Chart of Accounts later on), it will add to the existing O-File whatever additional changes 
you have made** 

11.Click  
12. Click [Ok] 

13. Click . The file has been created and is ready to FTP Transfer to the 
stores. 

 

How to Create Exception Parameters List and Send it to the Stores 
 
**Note: When sending an Exception Parameter List, the file will be sent to the selected 
store. Therefore, ensure that this List is suitable for the selected store. If not, individual 
changes must be made in the E2 Management Suite** 
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1. Click [Account Maintenance] 
2. Click the [Exception 

Parameters] Tab 
3. Select the Store from the 

drop-down 
4. Enter in all Parameter 

information in the provided 
cells. **Double Click in the 
cell to enter information** 

5. Click [Flag]. This will force 
the item to highlight the 
related information, or “flag” it. 

6. Once all changes are made, click  

7. Click  
8. Select which reports you wish to send to the stores: 

 
**Note: If you edit a report, and decide to edit a different one later on (Exception 
Parameters List now, Chart of Accounts later on), it will add to the existing O-File 
whatever additional changes you have made** 

9. Click  
10. Click [Ok] 

11. Click . The file has been created and is ready to FTP Transfer to the 
stores. 

Accounts and Vendors 
 
This module lists all store-specific Chart of Account and Vendor information. This 
information may be edited at the office, but must be done through Account Maintenance.  
 
Chart of Accounts: 
Lists all store-specific Chart of Account information including accounts for: Deposits, 
Paid Outs, Invoices, Other Income, etc.  
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Vendor Information: 
Lists all store-specific Vendor 
Descriptions and Names  
 
 
 
 

Transaction Journal 
 
The Transaction 
Journal is where all 
store-specific account 
information is stored. 
This information 
includes: Deposits, Paid 
Outs, Invoices, Other 
Income, and 
Redeposits. These transactions use the Chart of Accounts provided to the location, and 
populate the Cash Long/Short for the Daily Summary, Blue Book, and Ranking Reports.  
 

Transaction Summary 
 
Lists all store-
specific transactions 
based on the period 
selected in the 
Calendar Wizard.  
Report lists 
Transaction Type, Account Number (Chart of Accounts), Date of Transaction and 
Amount. Vendor/Payee, Vendor ID, and Invoice Number depend on the type of 
transaction listed (for example: a Cash Deposit will not have a Vendor ID).  
 
Multi-Store gives the option of viewing the Transaction Summary for all stores listed in 
the S2O. The same information is given, but is expanded to include all entries from all 
stores. 
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Cash Drop Summary 
 
Lists all store-specific Cash Drop information. This information includes Band #, Name, 
$ Amount, # of Tickets, Drop Times and Amount Owed. This report also lists all EFT 
Transactions (if PAYS enabled) and cash transactions listed separately. Coupon Sales, 
Open Tickets, and Employee Charges are listed as well.  

 

 
Cash Drop Summary Information can be viewed by all or by an individual employee. 
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Office Updates 
 
One of the many innovative features of Store2Office is its ability to self-update. S2O, as 
part of the FTP Transfer process, automatically checks the FTP Site for new updates and 
notifies the user if an update is found. 
 
After FTP File Transfer/Process Files is complete, the user will be notified of the new 
update with the following message, located at the top of the S2O Reporter: 
 

 
 

1. Click the Yellow Banner Text 
2. The New S2O Update box appears: 

 
 

3. Close all instances of S2O (if using Client@Main Office Setting) 
4. Click [Yes] 
5. The Install Shield Wizard will open: 

 
 

6. Verify the Destination Folder (default is c:\Program Files\Store2Office, but this 
may vary) 

7. Click [Next] 
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8. Click [Next] again to begin installation 
9. Click [Finish]. This will finish the installation and back up the Databases 
10. Open Store2Office Reporter, the Upgrade box will open: 

 
 

11. Click [Ok] 
12. Once Convert Process is finished, Store2Office Reporter will open automatically.  
 
**Do NOT attempt to open S2O Reporter again. Wait for the Convert Process to 
finish. This process may take a few minutes, depending on how much data is present 
in the S2O. If the process does not complete, call the OMC Support Center for 
technical assistance** 
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Contact Numbers for Order Matic  
 
Support Center Toll-Free (800)-767-6733 
Local Support Center (405) 672-1487 
 
Email Contacts 

 
General Information: info@ordermatic.com 
Sales and Marketing: Sales@ordermatic.com 
Billing or Account Information: Billing@ordermatic.com 
Training Programs: Training@ordermatic.com 
POS Tech Support: tech@ordermatic.com 
Software Support: software@ordermatic.com 

 
 
 
 
 
 
 
 


